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[bookmark: _Toc283481654]Summary
The Windows 8 WDK contains a major change to the build environment. The build environment no longer uses build.exe; instead it uses MsBuild.exe and is fully integrated with the Visual Studio IDE. This means that sources, makefile.inc, makefile.new and other related build files present in previous WDKs are no longer used. The Win8 WDK will enable you to create, edit, build, test and deploy a driver through Visual Studio.
The purpose of this document is to provide information that may facilitate users familiar with previous WDKs in getting started with the Win8 WDK, which offers a vastly different and improved developer experience. Furthermore, this document focuses specifically on the use of Nmake2MsBuild.exe, provided with the WDK, to migrate projects based on build.exe to the new MSBuild.exe based build environment in the Windows 8 WDK.
[bookmark: _Toc283481655]Getting Started
The current version of WIN8 WDK ships with samples and associated sources files. However, build.exe and support for the WDK7.0 build environment that could consume the sources files has been removed. The sources files are present to allow you to experiment with conversion from sources to a .VcxProj file that is consumed by MsBuild and Visual Studio. The release version of the WDK will not contain any sources files.
This section covers how to convert a sample in the WDK, or create a new driver project in Visual Studio, and then build these projects using the command line as well as Visual Studio. 
Section 4: Migrating Your Projects  discusses, in more details, techniques for converting your existing projects to the .VcxProj format.

[bookmark: _Ref283377360][bookmark: _Ref283377365][bookmark: _Toc283481656]Converting a WDK sample to a Visual Studio VcxProj format
In order to build an existing project using Visual Studio, you must first convert it to a .VcxProj project using Nmake2MsBuild.exe
	Tool Location:
	Bin folder in the WDK Installation location. Example: "C:\Program Files (x86)\Windows Kits\8.0\bin\x86\nmake2msbuild.exe"

	Example use:  
 
	[bookmark: _GoBack]cd "C:\Program Files (x86)\Windows Kits\8.0"
.\bin\x86\nmake2msbuild.exe  .\src\general\Cancel\sys\sources
[cancel.vcxproj will be generated alongside the sources file]

	For more options: 
	.\bin\x86\nmake2msbuild.exe  /?



[bookmark: _Toc283481657]Creating a new project in VS
[bookmark: _Toc283481658]Creating a new Driver Project
1. File →  New Project → Visual C++ → Windows Driver → Windows Driver Project

2. A Wizard will guide you the rest of the way.
[bookmark: _Toc283481659]Creating a User mode Application or DLL Project
For this scenario, you may proceed as you would when building an app or dll using VS previously, by selecting:
1. File → New Project → Visual C++ → Win32
However, if your project references libs and headers under paths traditionally pointed to via $(SDK_LIB_PATH) and $(SDK_INC_PATH), you will need to set the project’s Platform Toolset to Windows8.0SDK:
1. Right click on the project in the Solution Explorer, select Properties
2. Under Configuration Properties → General, select Windows8.0SDK from the Platform Toolset dropdown list.
3. Click Apply
You may also wish to explore which properties/macros are defined that you may reference instead of using hard-coded paths. To brown this list:
1. From within the open property page, select any property under the General section
2. Click on <Edit..> is the drop down list that appears in the property value field. 
3. Click the Macros button to see the values of existing macros:
[image: http://windows/windows8/dnt/hdx/wdk/Pictures%20for%20website/MacroExplorer.png]
[bookmark: _Toc283481660]Building a project using the VS IDE
Once a driver project is opened in VS, you may interact with it in much the same way as a regular C/C++ project. To build a project:
1. Open the existing project in VS by double clicking on the .VcxProj file.
2. Build the project as usual in Visual Studio (Ctrl+Shift+B or  Build →  Build Solution)

The default build configuration is Win32|Windows 8 Debug, which corresponds to Win8 x86chk in the older WDK build window shortcuts.

The configuration may be changed by using the Configuration manager:
1. Right click on the project in the Solution Explorer, select Properties.
2. Click the Configuration Manager Button, top right
[image: ]
 
 
[bookmark: _Toc283481661]Building a project using VS command line and MsBuild
The WDK no longer contains one build environment shortcut per build-configuration of target OS + target processor + build type. Instead, we now use the Visual Studio Command Prompt for all build configurations:
Start →  Microsoft Visual Studio 2010  →   Visual Studio Tools →  Visual Studio Command Prompt (2010).lnk
Within this environment you may call MsBuild to build any project using the associated .VcxProj or .Sln file. Following is common syntax to help you get started:
msbuild /t:clean /t:build .\cancel.vcxproj
The default build configuration is Win8 Win32|Debug, which corresponds to Win8 x86chk in the older WDKbuild window type. The configuration may be changed by altering the “Platform” and “Configuration” properties. You may specify values for properties in the VcxProj file, or provide them at the command line using /p:<name>=<value> which overrides existing definitions in the project.
	MsBuild Property
	Possible Values

	Platform
	Win32, X64

	Configuration
	Windows 8 Release
Windows 8 Debug
Windows 7 Release
Windows 7 Debug 
Vista Release
Vista Debug



msbuild /t:clean /t:build .\cancel.vcxproj /p:Platform=Win32 /p:Configuration=”Windows 7 Release” 
The /t flag in the above command line invokes a specific target. The default target, if one is not specified, is the build target. However, the above call will additionally clean the project directory of previously generated files before attempting another build.
For more details regarding MsBuild please refer to the MSDN MsBuild Reference 
[bookmark: _Ref283370496][bookmark: _Ref283370525][bookmark: _Ref283370545][bookmark: _Toc283481662]Migrating Your Projects
The project conversion process makes no distinction between converting a WDK sample, and converting any of your existing projects. Hence the basics of conversion, outlined in section 3.1 Converting a WDK sample to a Visual Studio VcxProj format , continue to apply. This section is dedicated to a more in-depth discussion of the Nmake2MsBuild tool, the level of conversion it promises, and means to extend the tool in order to adapt to configurations specific to your previous build environment, if any.
[bookmark: _Toc283481663]Setting Expectations
For the vast majority of projects, the conversion process will yield a .VcxProj file that will closely map to the original sources file, and the .VcxProj project will build successfully. However, the tool is under development; please refer to Section 5: Features Under Development, to see if any of your projects use features that cannot be converted automatically, for the moment. Furthermore, it should be noted that the tool is not intended to guarantee accurate conversion of all projects, especially ones that leverage modifications to makefile.new etc. For advanced users that may have modified the build environment previously, we provide the ability to guide the conversion process by specifying custom rules; minor manual tweaking of the resulting .VcxProj file may be necessary, however.
[bookmark: _Toc283481664]Suggested MSBuild Background
The following MSDN links should provide sufficient background for users looking to understand the .VcxProj format, capabilities and requirements as well as to debug any issues with converted projects. This is recommended reading, especially for those users that need to extend the Nmake2MsBuild tool by specifying custom rules.
I. MSBuild Overview
II. Further Topics
III. MSBuild Reference
[bookmark: _Toc283481665]Conversion Strategy
The Nmake2MsBuild tool performs a rule-based mapping of contents of a sources file a .VcxProj file. Per macro that is to be converted, we specify a conversion rule in a .props file that is consumed by MSBuild and instrumented during build. In the MSBuild environment, Properties, Items and Metadata on those items are consumed by the build system. Hence, each macro in the sources file is mapped to either an MSBuild Property, Item, or Item Metadata, as specified by the rule. By default, if no rule is present, a macro named A with the value B is converted to Property A with the value B.
The initial conversion step involves a mapping of NMake syntax in a makefile.inc  or sources file to MSBuild syntax in an associated .props file. Each macro in the NMake file is converted to a Property in the .props file. During build time, these properties are evaluated, and the evaluated values of certain properties are then mapped to various other properties, items or metadata, as specified by a conversion rule.
As an example, consider the USER_C_FLAGS macro in sources, which is used to specify command line parameters to be passed to cl.exe during compilation. In the MsBuild environment, the ClCompile item list contains the source code files to be compiled, and is consumed by the CL Task. The CL Task documentation indicates that the AdditionalOptions metadata on each item in the list determines the additional flags passed to cl.exe. Hence, the value of the USER_C_FLAGS macro should be mapped to the AdditionalOptions item metadata for items of type ClCompile. In the initial conversion step, the macro USER_C_FLAGS in a sources file is converted to an MSBuild property also named USER_C_FLAGS in sources.props, a newly generated file. The mapping of the evaluated value of the USER_C_FLAGS property to the AdditionalOptions metadata occurs at build time by the following:
  <!-- Contains rules to map compiler and linker switches -->
  <ItemDefinitionGroup>
    <ClCompile>
      ...
      <AdditonalOptions>%(AdditionalOptions) $(User_C_Flags)</AdditonalOptions>
      ...
    </ClCompile>
  </ItemDefinitionGroup>

The above is a snippet from the PostToolsetRules.props file. The above xml uses an MsBuild ItemDefinitionGroup to specify that the AdditonalOptions metadata all items of type ClCompile should have  $(User_C_Flags) appended to it. 
All rules are specified using standard MsBuild syntax, as these are instrumented by the MsBuild engine.

[bookmark: _Ref283475871][bookmark: _Toc283481666]Default Rules File
The default rules that are used for conversion are specified in PostToolsetRules.props located at:
Windows Kits\8.0\Tools\x86\Conversion\PostToolsetRules.xml
This file should serve as a reference for the user to create any new rules necessary for conversion of their projects.
[bookmark: _Toc283481667] User Specific Rules
Other than the default rules file mentioned in section 4.4, which is always used during conversion, the user may also create an optional User-Rules file that dictates further rules for conversion of any Macro that may be specific to build environment under which the project was build previously.
[bookmark: _Toc283481668]When User Rules Are Necessary
The rules supplied by Microsoft will only support conversion of projects that the use macros and targets defined in the Windows 7 WDK, for example those in makefile.new. Conversion of any projects that leverage functionality added or modified by the user in the previous build environment is not guaranteed to be automatic.
As a rule of thumb, a user rules file will likely be necessary if an existing project does not build in a fresh installation of the Windows 7 WDK without modification of the sources or .inc files associated with the project, or any other files installed by the WDK.
[bookmark: _Toc283481669]Creating and Using a User Rules File
A user-specific rules file should follow standard MsBuild syntax, as well as the design patterns exhibited by default rules file mentioned in section 4.4. Until further documentation is developed, the default rules should serve as sufficient example for developing all but the most complex conversion rules.
The order in which files are imported in a .VcxProj file, and rules instrumented, is critical and should be maintained. It is recommended that the user developed rules file be imported in to the project immediately after the Microsoft supplied PostToolsetRules.props:
  <Import Project="$(PostToolsetRules)" />
  <!-- Import PostToolsetRules to map nmake properties/macros to msbuild properties/items/metadata -->
[bookmark: _Ref283379892][bookmark: _Ref283379895][bookmark: _Toc283481670]Features Under Development
Currently, the following features of the conversion tool are under development:
· Conversion of custom targets, as well as some non-build-critical targets such as BinPlace. (binplace itself is supported in the new msbuild.exe based build system)
· Ability to view all settings for converted projects in the Visual Studio Property Sheets.
This does not imply a lack of this functionality in the WIN8 WDK build environment but rather the inability of the Nmake2MsBuild tool to automatically convert these features at this time.  As the Win8 WDK progresses towards release, more conversion functionality will be added based off of our testing and your feedback.
[bookmark: _Toc283481671]Known Issues
For known issues with the WIN8 WDK in general, please consult the KnownIssues.docx document.
[bookmark: _Toc283481672]Providing Feedback
If you experience a conversion or build-related issue not listed in the known issues, be sure to include the following information along with a description of the issue in your feedback to Microsoft. Of course, we welcome feedback regarding any other aspect of the WIN8 WDK as well.
1. The .VcxProj and all .props files generated by the Nmake2MsBuild tool, as well as the Nmake2MsBuild_*.log file(s).
2. The sources, sources.inc, makefile.inc and other build system configuration files, especially if conversion failed. Note: this refers only to the build configuration files, not the actual source code.
3. Verbose MsBuild log generated using the /v:diag command line option e.g. msbuild /t:clean /t:build .\cancel.vcxproj /v:diag > msbuild.log
4. Any additional information regarding your project, relevant to understanding the issue.
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